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ShareScopelro

Getting Started Tutorial

ShareScope Plus and Pro can look daunting when you first open them but
you’ll soon discover just how easy they are to use. We recommend you follow
this tutorial first — it will teach you the basic structure and features of
ShareScope in around 20 minutes. Plus and Pro share a common interface.
For simplicity, we will refer to “ShareScope” in this document.

Starting up ShareScope
When you start up ShareScope Pro a number of windows may automatically
display on your screen:

New features in ShareScope Plus/Pro

Explains any new features included in the current release of software. This
document also provides links to previous release notes as well. It is well
worth reading this document as it may contain features not yet in the User
Guide. Close the window for now — you can find it later on the Help menu.

Comms Setting
In order to update your end of day stock market and fundamental data,
ShareScope needs to be able to communicate with the outside world.

When you first open ShareScope it will prompt you to check that the
communication settings are correct. Click OK to display the Comms Setting
dialog. By default, ShareScope is configured to communicate using your
internet account and should not require further configuration by you. Click on
OK to close this window.

Tip of the Day

This is a great way to learn about the features of ShareScope. A new tip will
be displayed each time you start ShareScope. You can switch this off if
preferred. This feature resides on the Help menu. Close it for now.
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Intraday feed levels

Allows you to select what level of feed you would like to receive for each of
the markets. Click on Next when this dialog appears and make your selection
in the next dialog. The Maximum level is every bit of data, Normal is 15
second snap shot prices and Minimum is one minute price data. Click on
Finish when you have made your selection. You can access this dialog again
at any stage in the future by going to the Update menu at the top of the
screen and clicking on ‘Select intraday feed levels’.

The basic structure of ShareScope Pro

ShareScope Pro has a multi-window format — enabling you to view different
types of information simultaneously: graphs, lists, company results, trade
information, news, and Directors’ dealings.

The layout on the screen when you first open the program is called ‘Main
Layout’ and consists of a list table and three graph windows. The two graphs
at the bottom of the layout are linked to the list of shares, so whichever share
is highlighted in the list, the same share will show in the two graph windows.
You can move to the next share in the list by pressing the Spacebar and all
three windows will change to display the next share in the list. Press Shift
and Spacebar to move back up the list.

Examples of other layouts have been set up as defaults. Click on the 9
Graphs, One Share or Portfolio buttons at the bottom of the screen to see
some of the other default layouts. You can have up to 12 layouts — go to the
Window menu at the top of the screen, then to Window layouts to view the
other layouts. You can also add more layout buttons to the toolbar — for
information on how to do this, see the Toolbar section in the on-screen Help.

There are four main screens in ShareScope — the List screen, Historical
Graph screen, Intraday Graph screen and Details screen. You can cycle
between these screens for the selected share by pressing the Enter key on
your keyboard. Use the Esc key to scroll through in the reverse order.

Other screens that are available are the Share’s News screen (press \ on
your keyboard, then \ again to return to where you were); Directors’ Dealings
screen (press . (full stop) on your keyboard and again to return); or the
Trades and Quotes screen (press ‘ (apostrophe) on your keyboard and again
to return to where you were). Of course you can add new windows for each of
these screens if you want to.

To add a new window to a layout, right click anywhere in the screen and go to
New Window, then select the type of window you would like to see. You can
resize the windows by moving your cursor to the edges of the window and
when the cursor changes to a double headed arrow, left click and drag your
mouse to move the edge of the window. To move the entire window to a new
position on the layout, left click on the blue title bar of the window and drag the
window.
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You can link windows together so that information for the same selected share
is shown simultaneously in any number of windows that you have linked
together on the same layout. To link a window, select the window first, then
go to the Window menu at the top of the screen and select Link window. In
the dialog that appears select the window you want to link this window to. The
window you linked will now show data for the same share as the window you
linked it to.

Finding a Share

To find a share from any screen in ShareScope simply start typing the first few
letters of its name. A dialog box is displayed with a selection of shares that
match the letters you typed. There are three ways of searching for shares in
ShareScope Pro:

1. Search by typing the name of the share and getting ShareScope to
start searching from the first letter (‘Start from first letter’ option)

2. Search by typing the EPIC code (‘Use EPIC codes’)

3. Use either any part of a share name OR the EPIC code, depending on
what you have to hand (untick both search options)

The dialog will only show shares from the list you are currently using. The
name of that list appears at the top of the selection dialog box. Select the
share you want from the displayed list, and, if requested, specify the share
type you want to view. The selected share will now be showing on your
screen.

Updating your data

When you first install the program you will have nearly all of the historical data
and may only be missing the last few days’ or weeks’ data. There is no
intraday data or news stories in the program when you first open it.

End of Day Data

The UK end of day data is made available from 6pm each week night. To
download the data, click on the Update data button on your toolbar.
Alternatively you can press F9 on your keyboard. US end of day data can be
downloaded in the same way after 10.30 pm. Fundamental and Unit Trust
data is available usually mid-morning and Investors Chronicle Views every
Friday at noon.

Intraday Data

To receive Intraday data, you need to press the Connect button on your
toolbar (or go to the Update menu and click on Connect to intraday feed).
The program will backfill all of today’s data, up until the time you connected
(or 15 minutes ago, if you have ShareScope Plus). Check your status in the
bottom right hand corner of the screen. When the backfill has finished your
status should read Connected. So long as you remain connected you will
continue to receive the intraday data. If you disconnect and then connect up
again later in the day the program will backfill the missed intraday data again.
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Once you are connected you can backfill previous days’ worth of intraday
data. Go to the Update menu and select Backfill intraday data. You can
backfill between 10 and 20 days data. Select the market(s) that you want to
see previous intraday data for, then select the day(s) and click on the
Request button. While you are backfilling data you can not request further
data to backfill; you can only backfill data when your status says Connected.

List Screen

The list screen can be fully customised to just show the information you are
interested in. To customise the columns that are shown, right click on any
existing to column heading to see what options are available to you. You can
add a wide range of different columns, divided into General columns, Intraday
columns, Price columns, Result columns, and others. You can rename the
column headings (Change heading...) or remove any columns currently in
the list that you do not want (Remove column).

The title bar of the list window will tell you what list of shares you are currently
viewing. To change to a different list, right click in the window and go to
Change List, then select a different list or portfolio to view; alternatively use
your list toolbar buttons (such as All or Shares) to change the current list.

You can further limit your lists to show just the shares that have reached a
new high or low, or show shares from a particular sector. To do this, right
click in the middle of the list and go to New Highs/Lows and click on New
Highs or New Lows, or go to Select sector and click on Choose the
sector...

ShareScope allows you to set up 12 tables containing different columns that
you can view the same list of shares in. At the bottom of your screen are
three Table buttons, these are shortcuts to the first three table settings. Click
on each of these to see the same list of shares but with different columns
displaying different types of information. To access all 12 settings, go to the
List Tables menu at the top of the screen. ShareScope will automatically
remember any changes you make to the List Tables.

Intraday Graph

So long as you are connected to the Intraday feed you should see two blue
charts on your screen; these are Intraday graphs. Look in the title bar of the
graph windows and you will see where it says ‘Intraday Graph’. These show
the price movement of the share during the day and are currently set to show
just one day’s data. The graphs can show up to 10 days intraday data,
however when you first install ShareScope you do not have any intraday
history so you will need to backfill the intraday data in order to show more
than the latest day. The graphs are currently showing you the bid (darker blue
shading) and offer (lighter blue shading) prices with a blue mid line through
the middle. The dots represent the trades — green for buy, red for sell and
blue for unknown trade types. The volume of each trade is shown in the
histogram below the graph. To zoom in on a specific period on the graph, left
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click and drag your mouse cursor to highlight the period you wish to view, then
let go of the mouse cursor. To return to the full day, double-click with your
mouse in the middle of the graph.

Right click in the middle of the graph to view the options available on the
graph context menu. From this menu you can add Moving Averages, Trend
Lines, Indicators, Market Graphs, Stop-Loss (Other main graph features)
and numerous line studies. To change the way the bid, offer and trade data
is displayed on the graph go to Graph design in the context menu.

As with List Tables, there are 12 Graph Settings in ShareScope. If you have
clicked in the graph window then the three toolbar buttons at the bottom of
your screen will now read Setting 1, Setting 2, Setting 3. Click on each of
these to view different examples of how you can display the data. To view all
12 Graph Settings, click on the Graph Settings menu in the main menu bar.

Historical Graph

The last window on the Main Layout is the historical graph. This shows the
entire price history that ShareScope holds of the selected share. You will see
that in the title bar this is just referred to as a Graph. The top left corner tells
you how the data is displayed — this may say ‘Pounds 4 week bars (dyn.)'.
This means that the values on the left and right hand side of the graph are in
pounds, that each bar on the graph represents 2 months worth of data and
that the data is displayed dynamically. With dynamically displayed data,
ShareScope will choose the best way to display the data. If you zoom in on a
small period of the graph (left click and drag over a section of the graph to
zoom in on that period) then the number of months or days per day will
change. Double click to return to the full history. If you want to only see the
last few months or years on the graph you can set ShareScope to always
display just the selected period. Right click in the graph, go to Limit date
range and select Set Date Range to modify and apply your settings.

The default settings for the graph show a moving average, trend line with
confidence lines and a volume histogram. The volume data only starts from
June 2000 and is not available before this date. To change the moving
averages or add analytical indicators, right click in the middle of the graph to
see the available options on the graph context menu. To customise how the
data is displayed and the colours on the main chart, select Graph Design
from the context menu.

There are 12 separate Graph Settings for Historical graphs as well. Use the

Settings buttons on the bottom toolbar to view the example set-ups, and use
the Graph Settings menu to access all 12.
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Details Screen

To access the Details screen, select one of the windows on your screen and
use either the Enter or Esc keys to cycle through the four main windows.

The Details screen comprises of List boxes, Results tables, Historical Price
graphs and Results graphs. This screen is again fully customisable by right
clicking in the window and using the options on the context menu. These
options include adding new boxes to the window, adding items to the boxes or
customising the boxes. There are also 12 Details Settings that you can use to
organize different information — use the toolbar buttons at the bottom of the
screen to view some examples, or go to the Details Settings menu at the top
of the screen to view all 12. Any changes you make will be saved when you
close the program down.

Portfolio Screen

You can create up to 1,000 portfolios or watch lists in ShareScope to maintain
your investments and to make comparisons of their performance against any
share, index or other portfolio.

When creating a portfolio you have the option to change any of your existing
windows on the screen into a portfolio, or you can add a new window to your
layout.

To change an existing window into a new portfolio:

1. Click on the Select Portfolio button on the top toolbar, or right click in
the window and go to Change window, then click on Select Portfolio
in the menu.

2. Click on <<new>> in the dialog box

3. Type in a name for your portfolio and click on OK.

To add a new window containing a new portfolio:

1. Right click in the screen and go to New window, then click on Select
Portfolio in the menu.

2. Click on <<new>> in the dialog box

3. Type in a name for your portfolio and click on OK.

A blank portfolio will be created in the window. To access this and any future
portfolios you create, click on Select Portfolio and choose the portfolio you
want to view from the list. Alternatively, to return to the last viewed portfolio
use the Current Portfolio option.

To add shares to your portfolio, right click in the blank screen and select Add
share to Portfolio. Type in the name of the share in the Find a share dialog
to add it to your portfolio. You can also access this dialog by pressing Ctrl
and A on your keyboard. To add shares to your portfolio from a different list
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or screen, right click in the screen and select Add share to portfolio from the
context menu.

The portfolio screen replaces the list screen in the view cycling — so press
Enter or Esc to scroll through from Portfolio to Historical Graph to Intraday
Graph to Details and back to the Portfolio list.

To record a transaction against a share in your portfolio, left click on the share
first to select it. Right click in the portfolio window and select Buy or Sell from
the context menu. A Record a transaction dialog will open, displaying the
last closing price as a guide. Enter the number of shares and any broker
charges and stamp duty paid. You can back-date your transactions so you
can add in any current holdings that you may have acquired in the past.

The transaction information is stored in the Transactions screen — each
portfolio has its own. To view this screen right click in the window and select
Transactions. If you have a keyboard with a number pad on the right, use
the + key to change to the Transactions view and the — (minus) key to return
to the portfolio view.

You may notice that the Summary line, just above the column headings, is
different in both screens. In the Portfolio screen the summary line tells you
information about the shares in the portfolio — the average price and up/down
movement as well as the capitalisation. In the Transaction screen the
Summary line gives you information about your holdings — the value and
increase or decrease in value as well as any potential or realised profit (or
loss). You can get the Transaction Summary in the Portfolio view as well. In
the Portfolio view, right click in the middle of the window and select
Investment Portfolio from the context menu.

Data Mining

Data Mining is ShareScope’s powerful stock screening utility. It enables you
to search the stock market for shares that meet specific criteria. To access
Data Mining, right click and go to either Change Window or New Window to
select Data Mining.

The Data Mining screen is comprised of three areas:

e The Control Panel where the Data Mining filters are selected and
configured

e The List of shares identified by the filter

e The Graph which shows the distribution of the shares according to three
of the search criteria.

For information on selecting, editing and creating Data Mining filters see the
User Guide or ShareScope’s Help facility. You may also be interested in
purchasing our Data Mining Training CD — more information about this is
available on our website.
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The Data Mining screen also replaces the list screen in the view cycling — so
press Enter or Esc to scroll through from Data Mining to Historical Graph to
Intraday Graph to Details and back to the Data Mining view.

ShareScope Help

All ShareScope features and menu items are explained in ShareScope’s on-
screen Help which can be accessed in a number of ways:

¢ Using the Help — Contents and Search facility on the Help menu you
can search for specific words or phrases.

e Many dialog boxes include a Help button which will display the relevant
Help page. Similarly, many dialog boxes include a “?” button in the top
right corner. Click on this button and then click on any item within the
dialog box to display context-sensitive Help.

e Use the F1 key to display context-sensitive Help. For example, if you
hover the mouse over an item on a menu, and then press F1, the
relevant Help will be displayed.

e Don't forget also: Tip of the Day, What's New, InfoCentre and the User
Guide. You can also discuss ShareScope and investing techniques with
other members on our discussion boards. You will find a link on the
Help menu within ShareScope.

If you require any further assistance, please do not hesitate to contact the
ShareScope Support team:

ShareScope Plus Support
call 0845 045 0111
email support@sharescope.co.uk.

ShareScope Pro Support

call 0845 456 0545
email pro@sharescope.co.uk.
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